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Preface

The NetWare® MultiMedia Server provides entertainment and information 
such as music, music videos, and presentation videos in the form of 
multimedia files. You can even have computer-based tutorials for education or 
entertainment purposes on your NetWare server, enabling users to access these 
tutorials from a workstation.
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� Understanding

This chapter gives the following conceptual information about the NetWare® 
MultiMedia Server.

What is the NetWare MultiMedia Server?

Using the MultiMedia Server

Supported Protocols

Supported Multimedia File Formats

Quality of Service

What is the NetWare MultiMedia Server?

The NetWare MultiMedia Server, which is a component of NetWare 5.1, 
introduces multimedia streaming capabilities on a NetWare server.

The MultiMedia Server suits any organization with a small, medium, or large 
network. It can be used for a variety of purposes, for example

� As a jukebox with audio files

� To serve multimedia tutorial files

� To store and display audio-visual presentations

Using the MultiMedia Server

To use the NetWare MultiMedia Server

� Install the MultiMedia Server component on the NetWare server.
Understanding �
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� Copy the multimedia files to a pre-defined location on the server. For 
more information about the supported multimedia file formats, see 
Supported Multimedia File Formats.

� On the workstation, install the multimedia player RealPlayer G2*. 
RealPlayer G2 is a free, downloadable software from RealNetworks Inc. 
(http://www.real.com)

� Launch RealPlayer G2 to play multimedia files from the server.

Supported Protocols

The NetWare MultiMedia Server supports Real Time Streaming Protocol 
(RTSP) for streaming audio and video on the network. RTSP (RFC 2326) is a 
client-server multimedia presentation control protocol, designed to address 
the needs for efficient delivery of streamed multimedia over IP networks. It 
works well both for large audiences as well as single-viewer media-on-
demand. For more information on RTSP and RFC 2326, see the Internet FAQ 
Archives (http://www.faqs.org/rfcs/rfc2326.html).

Supported Multimedia File Formats

Currently, the NetWare MultiMedia Server supports the following file 
formats:

� WAV - File format for storing digital audio (waveform) data.

� MP3 - MPEG-1 layer III. One of the best data-reduced (compressed) 
audio formats available.

� RM - RealVideo* file extension. RealVideo is a common Internet audio 
and video format, which supports streaming and live Web casts.

Quality of Service

For optimum performance, the NetWare MultiMedia Server provides a feature 
called Adaptive Quality of Service (Adaptive QoS). The primary function of 
Adaptive QoS is to adjust the required bandwidth depending on the network 
traffic. If the bandwidth available to a workstation is less than the required 
bandwidth, QoS regulates the multimedia data being transferred to the 
workstation. This way, the congestion in the network minimally affects the 
performance of the multimedia files being played from the MultiMedia 
Server.
�� NetWare MultiMedia Server Guide
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� Installing

Before you install the NetWare® MultiMedia Server, ensure that the minimum 
hardware and software requirements on the workstation and the server are 
met.

Requirements

Server Requirements
� NetWare 5.1

� You should have enabled the TCP/IP protocol for network 
communication (installed by default with NetWare 5.1).

Client Requirements

� RealPlayer G2 to play multimedia files. RealPlayer uses the Real Time 
Streaming Protocol (RTSP) on the network to interface between the 
workstation and the MultiMedia Server. For more information, see 
Installing RealPlayer G2.

� DirectShow* for RealPlayer G2 to play MP3 files over the network. For 
more information, see Installing DirectShow.

� WAV and MP3 plug-ins for RealPlayer G2. These will automatically be 
downloaded from the Internet and installed the first time you launch 
RealPlayer G2 and try to play WAV or MP3 files.

� An installed and configured sound card.

� TCP/IP for network communication on the workstation.
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Installation

On the Server

Installing NetWare MultiMedia Server During Server Installation

�� During server installation, select Custom installation.

�� Select NetWare MultiMedia Server.

,03257$17� While installing NetWare MultiMedia Server, an additional 
component, NetWare Web Manager, will also be selected for installation. NetWare 
Web Manager is a Web-based administration utility for several NetWare 5.1 
components.

Installing NetWare MultiMedia Server After Server Installation

When you want to install the NetWare MultiMedia Server component after 
installation of NetWare 5.1, complete the following tasks:

�� Load the nwconfig utility from the server console > select Product 
Options.

�� Select Install a Product Not Listed.

�� Select NetWare MultiMedia Server.

,03257$17� While installing NetWare MultiMedia Server, an additional 
component, NetWare Web Manager, will also be selected for installation. NetWare 
Web Manager is a Web-based administration utility for several NetWare 5.1 
components.

Loading and Unloading the MultiMedia Component

After the installation, the MultiMedia Server component is not loaded 
automatically when the server comes up. You have to load the component on 
the server by entering the following command at the server console:

media

You can also load the component in protected memory space by entering the 
following command at the server console:

protect media

A protected memory space has limited and carefully controlled access to the 
server operating system, so that modules running within the protected space 
cannot abend the server.
�� NetWare MultiMedia Server Guide
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To unload the MultiMedia Server component, enter the following command at 
the server console:

umedia

On the Workstation

Installing RealPlayer G2

Download the latest RealPlayer G2 (http://www.real.com). Run the setup 
program of the downloaded file and follow the installation instructions to 
setup RealPlayer G2 on the workstation. After you have installed RealPlayer 
G2, you have to install DirectShow 6.x, which enables you to play MP3 files 
from the server, using RealPlayer.

Installing DirectShow

To play MP3 files using RealPlayer G2, you need to install DirectShow (http:/
/www.bitcasting.com/products/demo/samples.shtml), version 6.0 or above, 
over RealPlayer. Run the setup program of the downloaded file to install 
DirectShow on your workstation.

,03257$17� After installing RealPlayer G2, when you try to play WAV or MP3 files for 
the first time, you will be prompted to download missing plug-ins. Click Yes to connect 
to the Internet to download and auto-install the plug-ins.

Configuration

Configuring the MultiMedia Server

To configure the MultiMedia Server, you must log in to the server as an 
administrator, or as a user with administrative rights.

Modifying the Location of Multimedia Files

You can specify the location where you will store your multimedia files. It is 
from this location that the MultiMedia Server will serve files to the clients.

To modify the location of these files:

�� Use a text editor to open the MEDIA.CFG file in the SYS:\ETC directory.

�� Specify the new location against the MMFilePath parameter (for 
example, MMFilePath SYS:\MULTIMEDIAFILES).

�� Save the file.
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�� Unload and reload the MultiMedia Server.

For details on loading and unloading the component, see Loading and 
Unloading the MultiMedia Component.

,03257$17� The default path for the multimedia files is 
SYS:\PUBLIC\MEDIACONTENT. For clients to access the multimedia files on the 
server, the directory should have Public access rights.

Configuring Adaptive QoS

To configure Adaptive QoS:

�� Use a text editor to open the MEDIA.CFG file in the SYS:\ETC directory.

�� Set the value of the AdaptiveQoSMode parameter to a value between 0 
and 100 (for example, AdaptiveQoSMode 15).

�� Save the file.

�� Unload and reload the MultiMedia Server. 

For details on loading and unloading the component, see Loading and 
Unloading the MultiMedia Component.

The Adaptive QoS value indicates the percentage of data packets to be 
dropped while sending the files to the clients, depending on the network 
traffic. A zero value disables Adaptive QoS. A value of 100 indicates that the 
streaming is optimized to maintain the quality of service at the workstation 
when there is high network traffic.

By default, Adaptive QoS is disabled on the MultiMedia Server.

Limiting the Number of Concurrent Client Connections

The maximum number of concurrent client connections allowed by NetWare 
MultiMedia Server is 50.

To limit the number of concurrent client connections to the MultiMedia 
Server:

�� Use a text editor to open the MEDIA.CFG file in the SYS:\ETC directory.

�� Set the value of the MaxClients parameter to a value between 1 and 50 
(for example, MaxClients 15).

�� Save the file.

�� Unload and reload the MultiMedia Server.
�� NetWare MultiMedia Server Guide
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For details on loading and unloading the component, see Loading and 
Unloading the MultiMedia Component.

The default value is 50. In the above example, the MultiMedia Server is 
set to allow a maximum of 15 concurrent client connections. Any value 
set below 1 will be taken as 1 and a value above 50 will be taken as 50.

,03257$17� When the CPU utilization on the server is very high at around 98%, 
the server refuses further client connections.

When there are more concurrent client connections, the available resources on 
the NetWare server are reduced. To increase resources, you can change the 
Maximum Packet Receive Buffers value on the server, to a higher value.

To change the value:

�� Load the monitor utility at the server console.

�� Select Server Parameters > Communications.

�� Change the value of Maximum Packet Receive Buffers to a higher value.

+,17� The default value on the server will be 500. You can set the value to 
approximately 100 per client connection. For example, if you plan to allow 50 
concurrent connections, you can set the value to 5000.

You can also change the Maximum Packet Receive Buffers value by typing 
set maximum packet receive buffers=5000 at the server 
console to set the value to 5000.
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� Using

You can launch RealPlayer G2 on the workstation to play the multimedia files 
that are on the server.

Playing Multimedia Files

To play multimedia files from the server:

�� Launch RealPlayer G2 on the workstation.

�� Click File > Open Location.

�� Type the location of the multimedia file, as shown in the following 
example:

rtsp://server_name/CATHAY.RM

where server_name is the network name of the MultiMedia Server.

�� Click OK.

+,17� If your NetWare® MultiMedia Server does not have a DNS entry on the network, 
you can access the server by typing the server’s IP address instead of its computer 
name.

The files should exist in the location you specified earlier. For configuring the 
location for multimedia files, see Modifying the Location of Multimedia Files.

Similarly, you can also play WAV and MP3 files by specifying their path as 
shown in Step 3.

If you have files in a sub-directory in the multimedia files root directory, then 
you enter the full path in the Open Location dialog box. For example rtsp:/
/server_name/MP3FILES/SONG1.MP3 where MP3FILES is a sub-
directory under the directory configured for storing files.
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,03257$17� While playing an RM file from the server on a TCP/IP network, the file 
plays till the end but does not return to Start after finishing, nor does it skip to the next 
file when playing from a playlist.

If you have paused an MP3 file during play, it will sometimes not resume play when Play 
is clicked again. You will have to stop and start playing the file again.

Using Novell Directory Services to Play Multimedia Files

Using Novell Directory Services® (NDS®), which is installed by default with 
NetWare 5.1, you can also play multimedia files stored in a user’s home 
directory on any server in the same NDS tree. For example:

�� Launch RealPlayer G2 on the workstation.

�� Click File > Open Location.

�� Type the location of the multimedia file, as shown in the following 
example:

rtsp://server_name/~JOHN/CATHAY.RM

where server_name is the network name of the MultiMedia Server, JOHN 
is the NDS username of a user on the network, and CATHAY.RM is a 
multimedia file that exists in the home directory of the user.

In the above example, the home directory of user John can exist on any 
server in the NDS tree.

�� Click OK to play the file.

,03257$17� The usage of ~ before the username is mandatory.

Creating Multimedia Playlists

You can organize your multimedia files by creating playlists. Playlists help 
clients categorize the multimedia files available to them on the MultiMedia 
Server. A playlist is a single file in which you make a list of the multimedia 
files you want the clients to access. These playlist files can be shared on the 
network for all clients to access.

,03257$17� Playlist files can exist either on the MultiMedia Server or any computer 
on the network.

To create a playlist:

�� Open a text editor.
�� NetWare MultiMedia Server Guide

NetWare MultiMedia Server Guide
104-001224-001

December 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 28 October 99
�� Type the file list in the following manner:

rtsp://server_name/FILE1.MP3

rtsp://server_name/FILE2.WAV

rtsp://server_name/FILE10.RM

�� Save the file with any extension. Preferably, name the playlist files in 
such a way that users know the category of files they are going to play. 
For example, WAVFILES.LST would indicate that the playlist file 
contains references to WAV files on the MultiMedia Server.

�� Launch RealPlayer G2 on the workstation.

�� Click File > Open File...

�� Select the playlist file you want to play > click Play.

For more information on playing multimedia files using RealPlayer G2, see 
Playing Multimedia Files.

The multimedia files should exist in the location you specified earlier. For 
configuring the location of multimedia files, see Modifying the Location of 
Multimedia Files.
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� Troubleshooting

This section lists the error messages you could encounter while using the 
NetWare® MultiMedia Server, and the actions to be taken.

Client Error Messages

� The RealPlayer is unable to connect to the server to play your selection.

� Requested file not found. The link you followed may be outdated or 
inaccurate.

� Connection to the server has been lost. You may be experiencing network 
problems.

� Connection to the server has timed out. You may be experiencing network 
problems.

� General Error. An error occurred. MPEG by Bitcasting Error 3. Renderer 
failed to open rendering device.

The RealPlayer is unable to connect to the server to play your 
selection.

Possible cause: The MultiMedia Server may be down or not responding. The 
network connection to the MultiMedia Server may also be lost.

Action: Check the status of the server. If the server is down, start the server, 
then play files from the server. Also, check your network connection.
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Requested file not found. The link you followed may be outdated or 
inaccurate.

Possible cause: The file you requested for playing does not exist on the server. 
The file may also not be within the directory configured to store multimedia 
files for playing.

Action: Check the exact name of the file you wish to play. Ensure that the file 
exists in the specified directory.

Possible cause: The file is corrupt.

Action: Contact your system administrator to replace the corrupt file.

Possible cause: You do not have the required access rights to the file you want 
to play.

Action: Contact your system administrator to grant you access rights to the 
multimedia files on the server.

Possible cause: The file you are trying to play is not supported by the 
MultiMedia Server.

Action: For details on the supported audio file formats, see Supported 
Multimedia File Formats.

Possible cause: NetWare MultiMedia Server has not been loaded properly on 
the server.

Action: Contact your system administrator. Also see Loading and Unloading 
the MultiMedia Component.

Connection to the server has been lost. You may be experiencing 
network problems.

Possible cause: The MultiMedia Server might have gone down, or might have 
stopped responding.

Action: Check the status of the server. If the server is up and you are still not 
able to access it, check the network connection and try again.

Connection to the server has timed out. You may be experiencing 
network problems.

Possible cause: The MultiMedia Server might be down or not responding.
�� NetWare MultiMedia Server Guide
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Action: Check the status of the server. If the server is up and you are still not 
able to access it, check the network connection and try again.

Possible cause: RealPlayer G2 on your workstation is configured for a speed 
slower than the available network bandwidth.

Action: Configure RealPlayer G2 to the correct network bandwidth speed. 
You can do this by changing the bandwidth in the Options > Preferences > 
Connection screen of RealPlayer G2.

General Error. An error occurred. MPEG by Bitcasting Error 3. 
Renderer failed to open rendering device.

Possible cause: The player failed to recognize the MP3 file format.

Action: Play the file again. If you still experience a problem, check whether 
the file is corrupt.

Errors

When I am playing multimedia files using RealPlayer G2, it buffers 
the file for a long time.

Possible cause: RealPlayer G2 on your workstation is configured for a speed 
slower than the available network bandwidth.

Action: Configure RealPlayer G2 to the correct network bandwidth. You can 
do this by changing the bandwidth in the Options > Preferences > Connection 
screen of RealPlayer G2.
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� Novell Trademarks

Access Manager is a registered trademark of Novell, Inc. in the United States 
and other countries.

Advanced NetWare is a trademark of Novell, Inc. 

AlarmPro is a registered trademark of Novell, Inc. in the United States and 
other countries.

AppNotes is a registered service mark of Novell, Inc. in the United States and 
other countries.

AppNotes is a registered service mark of Novell, Inc. in the United States and 
other countries.

AppTester is a registered service mark of Novell, Inc. in the United States and 
other countries.

BrainShare is a registered service mark of Novell, Inc. in the United States and 
other countries.

C-Worthy is a trademark of Novell, Inc.

C3PO is a trademark of Novell, Inc.

CBASIC is a registered trademark of Novell, Inc. in the United States and 
other countries.

Certified NetWare Administrator in Japanese and CNA-J are service marks of 
Novell, Inc.

Certified NetWare Engineer in Japanese and CNE-J are service marks of 
Novell, Inc.

Certified NetWare Instructor in Japanese and CNI-J are service marks of 
Novell, Inc.

Certified Novell Administrator and CNA are service marks of Novell, Inc.

Certified Novell Engineer is a trademark and CNE is a registered service mark 
of Novell, Inc. in the United States and other countries.

Certified Novell Salesperson is a trademark of Novell, Inc.
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Client 32 is a trademark of Novell, Inc. 

ConnectView is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Connectware is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Corsair is a registered trademark of Novell, Inc. in the United States and other 
countries. 

CP/Net is a registered trademark of Novell, Inc. in the United States and other 
countries. 

Custom 3rd-Party Object and C3PO are trademarks of Novell, Inc. 

DeveloperNet is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Documenter’s Workbench is a registered trademark of Novell, Inc. in the 
United States and other countries. 

ElectroText is a trademark of Novell, Inc. 

Enterprise Certified Novell Engineer and ECNE are service marks of Novell, 
Inc. 

Envoy is a registered trademark of Novell, Inc. in the United States and other 
countries. 

EtherPort is a registered trademark of Novell, Inc. in the United States and 
other countries. 

EXOS is a trademark of Novell, Inc. 

Global MHS is a trademark of Novell, Inc. 

Global Network Operations Center and GNOC are service marks of Novell, 
Inc. 

Graphics Environment Manager and GEM are registered trademarks of 
Novell, Inc. in the United States and other countries. 

GroupWise is a registered trademark of Novell, Inc. in the United States and 
other countries. 

GroupWise XTD is a trademark of Novell, Inc. 

Hardware Specific Module is a trademark of Novell, Inc. 

Hot Fix is a trademark of Novell, Inc. 

InForms is a trademark of Novell, Inc. 

Instructional Workbench is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Internetwork Packet Exchange and IPX are trademarks of Novell, Inc. 

IPX/SPX is a trademark of Novell, Inc. 

IPXODI is a trademark of Novell, Inc. 
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IPXWAN is a trademark of Novell, Inc. 

LAN WorkGroup is a trademark of Novell, Inc. 

LAN WorkPlace is a registered trademark of Novell, Inc. in the United States 
and other countries. 

LAN WorkShop is a trademark of Novell, Inc. 

LANalyzer is a registered trademark of Novell, Inc. in the United States and 
other countries. 

LANalyzer Agent is a trademark of Novell, Inc. 

Link Support Layer and LSL are trademarks of Novell, Inc. 

MacIPX is a registered trademark of Novell, Inc. in the United States and 
other countries. 

ManageWise is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Media Support Module and MSM are trademarks of Novell, Inc. 

Mirrored Server Link and MSL are trademarks of Novell, Inc. 

Mobile IPX is a trademark of Novell, Inc. 

Multiple Link Interface and MLI are trademarks of Novell, Inc. 

Multiple Link Interface Driver and MLID are trademarks of Novell, Inc. 

My World is a registered trademark of Novell, Inc. in the United States and 
other countries. 

N-Design is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Natural Language Interface for Help is a trademark of Novell, Inc. 

NDS Manager is a trademark of Novell, Inc. 

NE/2 is a trademark of Novell, Inc. 

NE/2-32 is a trademark of Novell, Inc. 

NE/2T is a trademark of Novell, Inc. 

NE1000 is a trademark of Novell, Inc. 

NE1500T is a trademark of Novell, Inc. 

NE2000 is a trademark of Novell, Inc. 

NE2000T is a trademark of Novell, Inc. 

NE2100 is a trademark of Novell, Inc. 

NE3200 is a trademark of Novell, Inc. 

NE32HUB is a trademark of Novell, Inc. 

NEST Autoroute is a trademark of Novell, Inc. 

NetExplorer is a trademark of Novell, Inc. 
Novell Trademarks ��

NetWare MultiMedia Server Guide
104-001224-001

December 21, 1999
Novell Confidential



doc_tpl.fm Rev 99a 28 September 99
NetNotes is a registered trademark of Novell, Inc. in the United States and 
other countries. 

NetSync is a trademark of Novell, Inc. 

NetWare is a registered trademark of Novell, Inc. in the United States and 
other countries. 

NetWare 3270 CUT Workstation is a trademark of Novell, Inc. 

NetWare 3270 LAN Workstation is a trademark of Novell, Inc. 

NetWare 386 is a trademark of Novell, Inc. 

NetWare Access Server is a trademark of Novell, Inc. 

NetWare Access Services is a trademark of Novell, Inc. 

NetWare Application Manager is a trademark of Novell, Inc. 

NetWare Application Notes is a trademark of Novell, Inc. 

NetWare Asynchronous Communication Services and NACS are trademarks 
of Novell, Inc. 

NetWare Asynchronous Services Interface and NASI are trademarks of 
Novell, Inc. 

NetWare Aware is a trademark of Novell, Inc. 

NetWare Basic MHS is a trademark of Novell, Inc. 

NetWare BranchLink Router is a trademark of Novell, Inc. 

NetWare Care is a trademark of Novell, Inc. 

NetWare Communication Services Manager is a trademark of Novell, Inc. 

NetWare Connect is a registered trademark of Novell, Inc. in the United 
States. 

NetWare Core Protocol and NCP are trademarks of Novell, Inc. 

NetWare Distributed Management Services is a trademark of Novell, Inc. 

NetWare Document Management Services is a trademark of Novell, Inc. 

NetWare DOS Requester and NDR are trademarks of Novell, Inc. 

NetWare Enterprise Router is a trademark of Novell, Inc. 

NetWare Express is a registered service mark of Novell, Inc. in the United 
States and other countries. 

NetWare Global Messaging and NGM are trademarks of Novell, Inc. 

NetWare Global MHS is a trademark of Novell, Inc. 

NetWare HostPrint is a registered trademark of Novell, Inc. in the United 
States. 

NetWare IPX Router is a trademark of Novell, Inc. 

NetWare LANalyzer Agent is a trademark of Novell, Inc. 

NetWare Link Services Protocol and NLSP are trademarks of Novell, Inc. 
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NetWare Link/ATM is a trademark of Novell, Inc. 

NetWare Link/Frame Relay is a trademark of Novell, Inc. 

NetWare Link/PPP is a trademark of Novell, Inc. 

NetWare Link/X.25 is a trademark of Novell, Inc. 

NetWare Loadable Module and NLM are trademarks of Novell, Inc. 

NetWare LU6.2 is trademark of Novell, Inc. 

NetWare Management Agent is a trademark of Novell, Inc. 

NetWare Management System and NMS are trademarks of Novell, Inc. 

NetWare Message Handling Service and NetWare MHS are trademarks of 
Novell, Inc. 

NetWare MHS Mailslots is a registered trademark of Novell, Inc. in the United 
States and other countries. 

NetWare Mirrored Server Link and NMSL are trademarks of Novell, Inc. 

NetWare Mobile is a trademark of Novell, Inc. 

NetWare Mobile IPX is a trademark of Novell, Inc. 

NetWare MultiProtocol Router and NetWare MPR are trademarks of Novell, 
Inc. 

NetWare MultiProtocol Router Plus is a trademark of Novell, Inc. 

NetWare Name Service is trademark of Novell, Inc. 

NetWare Navigator is a trademark of Novell, Inc. 

NetWare Peripheral Architecture is a trademark of Novell, Inc. 

NetWare Print Server is a trademark of Novell, Inc. 

NetWare Ready is a trademark of Novell, Inc. 

NetWare Requester is a trademark of Novell, Inc. 

NetWare Runtime is a trademark of Novell, Inc. 

NetWare RX-Net is a trademark of Novell, Inc. 

NetWare SFT is a trademark of Novell, Inc. 

NetWare SFT III is a trademark of Novell, Inc. 

NetWare SNA Gateway is a trademark of Novell, Inc. 

NetWare SNA Links is a trademark of Novell, Inc. 

NetWare SQL is a trademark of Novell, Inc. 

NetWare Storage Management Services and NetWare SMS are trademarks of 
Novell, Inc. 

NetWare Telephony Services is a trademark of Novell, Inc. 

NetWare Tools is a trademark of Novell, Inc. 

NetWare UAM is a trademark of Novell, Inc. 

NetWare WAN Links is a trademark of Novell, Inc. 
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NetWare/IP is a trademark of Novell, Inc. 

NetWire is a registered service mark of Novell, Inc. in the United States and 
other countries. 

Network Navigator is a registered trademark of Novell, Inc. in the United 
States. 

Network Navigator - AutoPilot is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Network Navigator - Dispatcher is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Network Support Encyclopedia and NSE are trademarks of Novell, Inc. 

Network Support Encyclopedia Professional Volume and NSEPro are 
trademarks of Novell, Inc. 

NetWorld is a registered service mark of Novell, Inc. in the United States and 
other countries.

Novell is a service mark and a registered trademark of Novell, Inc. in the 
United States and other countries. 

Novell Alliance Partners Program is a collective mark of Novell, Inc. 

Novell Application Launcher is a trademark of Novell, Inc. 

Novell Authorized CNE is a trademark and service mark of Novell, Inc. 

Novell Authorized Education Center and NAEC are service marks of Novell, 
Inc. 

Novell Authorized Partner is a service mark of Novell, Inc. 

Novell Authorized Reseller is a service mark of Novell, Inc. 

Novell Authorized Service Center and NASC are service marks of Novell, 
Inc. 

Novell BorderManager is a trademark of Novell, Inc. 

Novell BorderManager FastCache is a trademark of Novell, Inc. 

Novell Client is a trademark of Novell, Inc. 

Novell Corporate Symbol is a trademark of Novell, Inc. 

Novell Customer Connections is a registered trademark of Novell, Inc. in the 
United States. 

Novell Directory Services and NDS are registered trademarks of Novell, Inc. 
in the United States and other countries. 

Novell Distributed Print Services is a trademark and NDPS is a registered 
trademark of Novell, Inc. in the United States and other countries. 

Novell ElectroText is a trademark of Novell, Inc. 

Novell Embedded Systems Technology is a registered trademark and NEST is 
a trademark of Novell, Inc. in the United States and other countries. 
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Novell Gold Authorized Reseller is a service mark of Novell, Inc. 

Novell Gold Partner is a service mark of Novell, Inc. 

Novell Labs is a trademark of Novell, Inc. 

Novell N-Design is a registered trademark of Novell, Inc. in the United States 
and other countries. 

Novell NE/2 is a trademark of Novell, Inc. 

Novell NE/2-32 is a trademark of Novell, Inc. 

Novell NE3200 is a trademark of Novell, Inc. 

Novell Network Registry is a service mark of Novell, Inc. 

Novell Platinum Partner is a service mark of Novell, Inc. 

Novell Press is a trademark of Novell, Inc. 

Novell Press Logo (teeth logo) is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Novell Replication Services is a trademark of Novell, Inc. 

Novell Research Reports is a trademark of Novell, Inc. 

Novell RX-Net/2 is a trademark of Novell, Inc. 

Novell Service Partner is a trademark of Novell, Inc. 

Novell Storage Services is a trademark of Novell, Inc. 

Novell Support Connection is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Novell Technical Services and NTS are service marks of Novell, Inc. 

Novell Technology Institute and NTI are registered service marks of Novell, 
Inc. in the United States and other countries. 

Novell Virtual Terminal and NVT are trademarks of Novell, Inc. 

Novell Web Server is a trademark of Novell, Inc. 

Novell World Wide is a trademark of Novell, Inc. 

NSE Online is a service mark of Novell, Inc. 

NTR2000 is a trademark of Novell, Inc. 

Nutcracker is a registered trademark of Novell, Inc. in the United States and 
other countries. 

OnLAN/LAP is a registered trademark of Novell, Inc. in the United States and 
other countries. 

OnLAN/PC is a registered trademark of Novell, Inc. in the United States and 
other countries.

Open Data-Link Interface and ODI are trademarks of Novell, Inc. 

Open Look is a registered trademark of Novell, Inc. in the United States and 
other countries. 
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Open Networking Platform is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Open Socket is a registered trademark of Novell, Inc. in the United States. 

Packet Burst is a trademark of Novell, Inc. 

PartnerNet is a registered  service mark of Novell, Inc. in the United States and 
other countries. 

PC Navigator is a trademark of Novell, Inc. 

PCOX is a registered trademark of Novell, Inc. in the United States and other 
countries. 

Perform3 is a trademark of Novell, Inc. 

Personal NetWare is a trademark of Novell, Inc. 

Pervasive Computing from Novell is a registered trademark of Novell, Inc. in 
the United States and other countries. 

Portable NetWare is a trademark of Novell, Inc. 

Presentation Master is a registered trademark of Novell, Inc. in the United 
States and other countries. 

Print Managing Agent is a trademark of Novell, Inc. 

Printer Agent is a trademark of Novell, Inc. 

QuickFinder is a trademark of Novell, Inc. 

Red Box is a trademark of Novell, Inc. 

Reference Software is a registered trademark of Novell, Inc. in the United 
States and other countries. 

Remote Console is a trademark of Novell, Inc. 

Remote MHS is a trademark of Novell, Inc. 

RX-Net is a trademark of Novell, Inc. 

RX-Net/2 is a trademark of Novell, Inc. 

ScanXpress is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Script Director is a registered trademark of Novell, Inc. in the United States 
and other countries. 

Sequenced Packet Exchange and SPX are trademarks of Novell, Inc. 

Service Response System is a trademark of Novell, Inc. 

Serving FTP is a trademark of Novell, Inc. 

SFT is a trademark of Novell, Inc. 

SFT III is a trademark of Novell, Inc. 

SoftSolutions is a registered trademark of SoftSolutions Technology 
Corporation, a wholly owned subsidiary of Novell, Inc. 
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Software Transformation, Inc. is a registered trademark of Software 
Transformation, Inc., a wholly owned subsidiary of Novell, Inc. 

SPX/IPX is a trademark of Novell, Inc. 

StarLink is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Storage Management Services and SMS are trademarks of Novell, Inc. 

Technical Support Alliance and TSA are collective marks of Novell, Inc. 

The Fastest Way to Find the Right Word is a registered trademark of Novell, 
Inc. in the United States and other countries. 

The Novell Network Symbol is a trademark of Novell, Inc. 

Topology Specific Module and TSM are trademarks of Novell, Inc. 

Transaction Tracking System and TTS are trademarks of Novell, Inc. 

Universal Component System is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Virtual Loadable Module and VLM are trademarks of Novell, Inc. 

Writer’s Workbench is a registered trademark of Novell, Inc. in the United 
States and other countries. 

Yes, It Runs with NetWare (logo) is a trademark of Novell, Inc. 

Yes, NetWare Tested and Approved (logo) is a trademark of Novell, Inc. 

ZENworks is a trademark of Novell, Inc.
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